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S32K SDK ISELED driver installation
guide

This document describes in detail the steps to install the necessary
components to build the customer application using the NXP S32K SDK
ISELED driver.

The S32 Software Development Kit (S32 SDK) is part of the S32 Design
Studio (S32DS), representing the tool suite for developing of user
applications for NXP Automotive and Ultra-Reliable microcontrollers.
S32K SDK ISELED driver is not integrated as part of standard S32SDK
installation, thus a few steps need to be done to download and
integrate the S32SDK ISELED driver into the application.

The 3 software packages that need to be installed are: S32 Design
Studio, $S32 SDK and SDK ISELED Driver.
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1. Downloading the S32 Design Studio IDE

The S32 Design Studio IDE is a complimentary integrated development
environment for Automotive and Ultra-Reliable Arm based MCUs that
enables editing, compiling and debugging of applications. Based on,
open-source software including Eclipse IDE, GNU Compiler Collection
(GCC) and GNU Debugger (GDB), the $S32 Design Studio IDE offers
designers a straightforward development tool with no code-size
limitations. NXP software, along with the $S32 Design Studio IDE provide
a comprehensive enablement environment that reduces development
time.

Note: Despite this document might refer to particular revision of
NXP SW, it is highly recommended to use the latest available
versions of the SW. Those versions might not be listed in the

screenshots presented in this document at the time of creation.

In order to download the $32 Design Studio IDE, please follow these
steps:

1.1.Visit the www.nxp.com/s32ds and download Design Studio v3.3
(or newer) for S32 Platform:

Software Versions Supported Products  Configuration Integrated NXP Compilers Debuggers Dedicated Tools
Software
S32Ds for S32 532V, 3328, and S32  Integrated NXP Tools: « S32 SDK +« NXP GCC6.3.1" Built-in GDB Vision:
Platform Platform devices « S32Flash . FreeRTOS . Green Hills mtgggcgiebugger . « NXP APU Compiler
« DDR stress . AMMCLIb for . IAR 532 Debug Probe « ISP Assembler
Integrated $32V23x P&E « ISP and APEX
Configuration Tools: . Vision SDK " graph tools
+ $32 Configuration « Multilink / Cyclone /
« Linux BSP Open SDA
» Pins Wizard
. Clocks Lauterbach supported
configuration
« Peripheral / Drivers
configuration
« DCD/VT
configuration
« DDR configuration
N
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IDE and Build Tools (2)

& FLEXERA 1KB S32DS-3-3
——

I $32 Design Studio 3.3 — Windows/Linux(REY 2:3)

‘ DOWNLOAD ‘

2020-06-22 13:28:00

I S$32 Design Studio 3.2 — Windows/Linux(REY 3.2)

& FLEXERA 1KB S32DS_32
—

‘ DOWNLOAD ‘

2019-09-27 15:18:00

1.2.To proceed with the download, the user needs to be logged-in
using the user account. In case of new user, please proceed
with the Register Now option prior logging into the NXP web

page.

==
==

&  Sign In or Register

Sign In

Email Address

Password

Forgot your passwiord?

I Don't have an account? Register Mo I

ABOUT NXP RESOURCES

@ENGLISH v W CART

ALL~ | Search Q

Having trouble?

If you are having trouble with registration or login, please opena
support request.

Employees:

Ifyou have a core ID {Legacy Freescale employees and new
employees hired at @ legacy Freescale facility): Log in using your
MNXP core ID and anelT passvord

Ifyou do NOT have a core ID iLegacy MNXP employees and new
employees hired at a legacy NP facility) Please follow
Insiructions to activate your mxp.com login, using your VWBI D
(¥PN access required for account activation)

FOLLOW Us News 5Jan 2018

1.3.Download the installation package of S32 Design Studio by
selecting the 3.3 version, based on the operation system on your
PC. After download, follow the instruction of the Installation

shield to proceed.
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Product Download

$32 Design Studio version v.3.3

Files License Keys MNotes

Show All Files =

© Download Help

6 Files
+  File Description + FiesSize % File Name s
<+ 532 Desgin Studio 3.3 release notes 196.3 KB # S32DS_Release_Notes_3.3.0.pdf
<+ 532 Design Studio 3.3 development packages for offline use 25GB # S32D53.3.0_D2006.zip
4 532 Deswgn Studio 3.3 installation for Linux 1GB & SSE)SS.S Iin&x D2006£]in

I 4+ 532 Design Studio 3.3 installation for Windows 1.4 GB # S32DS53.3_win_D2006.exe I

4 532 Design Studio 3.3 Installation guide 12MB # S32DS Installation Guide 3.3.0.pdf
<+ $32 Design Studio 3.3 S32K1xx development package for offline use 22GB # $32D5.532K1.3.3.0_D2006.zip

1.4.During the installation of the S32 Design Studio IDE, an Activation
code and the license file need to be stored on your computer.

Product Download

S$32 Design Studio version v.3.3

J Files

License Keys Notes

© Download Help

Show All Files

4+ [+

File Description

$32 Desgin Studio 3.3 release notes

S$32 Design Studio 3.3 development packages for offline use
532 Design Studio 3.3 installation for Linux

$32 Design Studio 3.3 installation for Windows

S$32 Design Studio 3.3 Installation guide

532 Design Studio 3.3 S32K1xx development package for offline use

6 Files

S FileSize ¥ File Name

1

1963 KB # S32DS_Release_Noles_3.3.0pdf
2.3GE $ $32D83.3.0_D2006 zip
1GB & S32D53.3_linux_D2006 bin
14GB # S32DS3.3_win_D2006.exe
12MB & S32DS_Installation_Guide_3.3.0.pdf
22GB # $32D8.S32K1.3.3.0_D2006.zip
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License Information
$32 Design Studio version v.3.3

View

Item Description 532 Design Studio version v.3.3
Order Number $32D5-3-3_114371747
Purchase Order Number

Total Number of Licenses 101

0

License Applicable to Product(s):
Version  Description
33 532 Design Studio version v.3.3 (View EULA)
100 Available
License Quantity: 1

Fulfillment ID: 175413747
Expiration Date:  Jul 15, 2024

Preduct: ; "
Machine:
Activation Code:

View Licenses

Below are the licenses you selected to view.

License O\'er\.'iewl Print Friendlyl Save All

License Applicable to Product(s):

Version Description
3.3 532 Design Studio version v.3.3

License Quantity: 1

FulfiimentD: |||

Expiration Date:  Jul 15, 2024
Product: 332 Design Studio version v.3.3

Machine:
Activation Code:

NXP Semiconductors, High Tech Campus 60, 5656 AG Eindhoven, the Netherlands PUBLIC
WWW.NXp.com



PR {

After successfully installing S32 Design Studio it's necessary to update

the S32 Software Development Kit (S325SDK), which comes pre-installed
with the §32 Design Studio. To proceed, please follow the instructions in
next chapter.

Note: If you already have the S32 Design Studio installed on your
computer, please make sure you update your installation, prior
proceeding to next chapter.

lio for 532 Platform

t ConfigTools

AR

Run  Window | Help

g e

@
.%- 1

BE @9 &

Getting Started

Help Contents
Search

Show Contextual Help

Show Active Keybindings...
Tips and Tricks...
Cheat Sheets...

Check for Updates
Install New Software...
Installation Details

53205 Extensions and Updates
About 532 Design Studio for 532 Platform
NXP Licenses

Ctrl+5Shift+L
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2. Updating the S32 Software Development Kit

The S32 Software Development Kit (S32 SDK) is an extensive suite of
robust hardware interface and hardware abstraction layers, peripheral

drivers, RTOS, stacks, and middleware designed to simplify and

accelerate application development on NXP S32K microconftrollers. As
the S32K SDK ISELED driver was tested with S32K SDK revision RTM 4.0.0,
the following steps need to be proceed in order to update to S32K SDK,

revision RTM 4.0.0:

2.1 Run the S32K Design studio
2.2  Select Help->Extensions and updates

io for 532 Platform

t ConfigTools Run  Window Help

AYRCH R R-RL

i

T

[ =4
A

o1

Getting Started

Help Contents
Search

Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
Tips and Tricks...

Cheat Sheets...

Check for Updates
Install Mew Software...
Installation Details

532D5 Extensions and Updates
About 532 Design Studio for 532 Platform
MXP Licenses
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2.3 Select and install S32SDK

532D5 Extensions and Updates

S32DS Extensions and Updates

S32KTXX RTM 4.0.0

& New o Installed £ Updates

Typeto Search...

VEFSION" 3.3\

$32SDK 532G274 BETA 0.9.0
version: 0.9.0

532SDK S32K1XX RTM 4.0.0
version: 4.0.0

$32K1xx development package
version: 3.3.0

$32K2xxTV development package
version: 3.3.0

$32K3xx development package
version: 3.3.0 EAR1

Installation details | Go to Preferences

532SDK 532K1XX RTM 4.0.0

Overview

The 532 Software Development Kit ($32 SDK) is an extensive
suite of peripheral drivers, RTOS, stacks and middleware
designed to simplify and accelerate application development on
NXP 532K ARM based microcontrollers.

This 532 SDK supports development with the following devices:
-832K116

-§32K118

- §32K142

- §32K142W

- §32K144

- S32K144W

Always show at startup I Install/Update 1 item(s) I

Reinstall Uninstall
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2.4  The next dialog will appear
m} X

w 53205 Extensions and Updates

S32DS Extensions and Updates

Confirm your action(s):
Press 'Mext/Finish' to continue with your actien. Or go back to choese more packages to install or update,

The following items will be installed:

532 5325DK S32K1XX RTM 4.0.0

version: 4.0.0

x NXP GCC for Arm Embedded Processors v9.2 build 1649
version: 1649

$32K1xx development package
version: 3.3.0

x NXP GCC for Arm Embedded Processors v6.3 build 2017 with EWL2

version: 2017

[ Always show at startup < Back Finish Cancel

2.5 Click on Next

Note: The list of available packages may differ as new support is
added. Please select all S32SDK S32K1xx RTM_4.0.0 related
packages in the list above.
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2.6  Accept the license agreement and click on Finish

% 532D5 Extensions and Updates m} X

S32DS Extensions and Updates

Licenses: License text:
> *Software License™ *Software License™ A
LA_OPT_BASE_LICENSE v13 March 2016
LA_OPT_NXP_Software_License v11 February 2020 'Sl:his Software and accompanying documentation are protected by United
- " - - tat
LA_OPT_NXP_Software_License v11 February 2020 ates

Copyright law and also by International Treaty provisions., Copyright
MXP Automeotive Software License Agreement v1.1 notices have been included in the Software.

P&E Microcomputer Systems, Inc ("PEMICRO") grants to the individual or
entity ("LICEMSEE") who received this Software from PEMICRO, either
directly or indirectly through ene of our authorized partners, a
non-exclusive and non-transferable License to use this Software with
PEMICRO's Cyclone, Multilink, Tracelink, OpenSDA, and OSITAG preducts
solely to develop, evaluate, or demonstrate source cede, Under no
circumstance may this product be used for production line programming or
be

used as part of a manufacturing process without PEMICRO's prior written
consent. All rights, title and interest in the Software are and shall

remain with PEMICRO. Under no circumstances may you copy this Software or
documentation for the purpose of distribution to others without prior
written autherization from PEMICRO. Under no conditions may you remove
the

copyright notices from this Software or documentation,

LICENSEE may not reverse engineer, decompile, or disassemble the
Software, nor attempt in any other manner to obtain the source code.
The Software is licensed as a single product. Its component parts
covered by this License may not be separated for use on more than one
Sa

U O o e ¥ Tt

(®) | accept the terms of the license agreements I

(U1 do not accept the terms of the license agreements

@ [ Abways show at startup < Back Cancel

2.7  Wait for installation finish. Once the updates are installed,
please proceed to the next stage, download and
installation of the S32K SDK ISELED driver, described in next
section.
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3. Installation of S32K SDK ISELED driver

The S32K SDK ISELED driver EAR 4.8.0 provides the user with necessary
API to initialize and drive the ISELED LEDs. It provides two options for
communication interface, highly effective FlexlO interface and
standard LPSPI interface. The S32K SDK ISELED driver is not part of
standard S32K SDK installation and a special activation code is needed
to download the installation package from NXP web. Please follow the
instructions to proceed:

3.1 Contact gpis.software@nxp.com or your NXP Sales
representative to get an Activation Code to register for the
Software.

3.2 Visit www.nxp.com/activation web page and log in using your
NXP web account. In case you do not have the NXP web
account, please proceed with the registration first.

W %ﬁb EMGLISH ~ J CART

ALL ~ | Search Q

@&  Sign In or Register

Having trouble?

Slgn II'I ) . ) ;

If you are having trouble with registration or login,
Email Address please open a support request.

Employees:
Password If you have a core ID (Legacy Freescale employees

and new employees hired at a legacy Freescale
facility): Log in using your NXP core ID and onelT
password.

If you do NOT have a core ID (Legacy NXP

employess and new smployees hired at a legacy
NXP facility): Please follow instructions to activate

I Don't have an account? Register Nox-.-'I your nxp.com login, using your WBI ID. (VPN access
required for account activation).

Forgot your password?
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h
P

>~ @ENGLISH v 1 CART

wir 1
A

ALL v Search... Q

& Software & Support Product Activation

Software and Support Activation g

Product

Enter Registration Code-

Example:
CWP-PRO-NL_1-387604471

3.3 Once the activation of the S32K SDK ISELED driver is done,
please navigate to My account option under your login

name.
wr 2 - ®ENGLISH v JCART
VAN
|
ORDERS
AlLv | g Q
' SIGN OUT

AMAZON WEB SERVICES AND NXP

Unleash Limitless loT Opportunity with Node-to-Cloud Connectivity

PRODUCTS SOLUTIONS DEVELOPER RESOURCES
Processors & Wireless Automotive More Products
Microcontrollers (MCUs) Bluetooth® Low Energy (BLE) In-Vehicle Network Analog
Arme-base SSOrS . "
Aumtchased Bidcessors MIFARE® MCUs and Processors Identification
L.MX Applications Processors NFC Radar Media and Audio
Kinetis® Cortexs-M MCUs Thread™ Secure Car Access Power Management
LPC Cortex-M MCUs Wireless Power All Automotive RF
N
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3.4 Select the Software Licensing and Support option.

m 2 - @ENGUSHv V/CART

PRODUCTS SOLUTIONS SUPPORT ABOUT ALL v ’ Search... ’ Q I

@ My Account

Welcome,

You logged in at

@ For the most up-to-date technical documents, select Documentation and Tools Updates below. The tool is updated daily
and is searchable and sortable by type, revision date dnd product.

2 PROFILE i SECURE APPLICATIONS

= Change My Password = Cross Check - Part Finder With Pricing

= Orders = Cross Check - Competitor Cross Reference
= Subscription Center =« eCommerce

= Documentation and Tools Updates = Compass Extranet

=« MCU Programming Center

= Moderated Downloads

@ SUPPORT

= View all Communities
= Software nsing and Support
= View all Support Methods

= My LPCXpresso activations

= ROM Programming

= View Existing Issues

NXP Semiconductors, High Tech Campus 60, 5656 AG Eindhoven, the Netherlands PUBLIC
WWW.NXp.com



3.5 Select Automotive SW — Middleware for General Purpose
and Integrated Solutions

m i 3 @ English ~
ALL ~ Search...

PRODUCTS APPLICATIONS SUPPORT ABOUT

MN¥P » Software & Support © Product List

Software & Support PrOd uct LiSt

Product List
Product Search
‘Welcome to the premier delivery, update, and software management service; designed to help you effectively
Order History manage your rapidly changing software from a secure, personalized website.

Recent Product Releases

Recent Updates To access an item, select a product below.

Licensing
License Lists
Offline Activation

FAQ
Download Help
Table of Contents
FAQs

Automotive SW — Mid are for General Purpose and Integrated Solutions

3.6 Select Automotive SW — ISELED Software

m L Account @ English~ = Cart
ALL ~ Q\

PRODUCTS APPLICATIONS SUPPORT ABOUT

MXP > Software & Support » Product Information : ive SW — Mi for General P and
Software &Su rt H
bpe Product Information
Product List
Product Search Automotive SW — Middleware for General Purpose and Integrated Solutions
Order History
Recent Product Releases
Recent Updates Your choice contains a suite of products. Please select one of the product lines below:

To register a New Product please click on the bution below
Licensing

Automotive SW — ISELED Software
FAQ Automotive SW - Touch Sense Software

License Lists
Offline Activati

Download Help
Table of Contents
FAQs

NXP Semiconductors, High Tech Campus 60, 5656 AG Eindhoven, the Netherlands PUBLIC
WWW.NXp.com



3.7 Select the SW32K1-ISELED-EAR-4.8.0 or newer package.

Below is an example screenshot for RTM 3.0.0, a previous
release.

m Products  Applications  Support  About

MNXP > Software & Support » Product Information : Automotive SW - ISELED Software

software & Support Product Information
Product List
Procuct Search Automotive SW - ISELED Software
Order History

Recent Product Releases

Recent Updates To register a New Product please click on the button below

Licensing

License Lists

Offline Activation Current Previous

FAQ

Version — Description
Download Help 3.00 = JSW32ZK1-ISELED-RTM-3.0.0 Download Log
Table of Contents ISELED middleware stack for control of Digital LED= using the ISELED protocol.
FAQs
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3.8 Accept the Software Terms and Conditions

w Products  Applications  Support  About

NXP » Software & Support » Software Terms and Conditions

Software & Support H'
o Software Terms and Conditions
Product List
Product Search SW32K1-ISELED-RTM-3.0.0
Order History
Recent Product Releases Please read the following agreement and click "| AGREE" at the bottom before downloading your software.
Recent Updates N
. . NXP ISELED® SOFTWARE LICENSE AGREEMENT v1.0
Licensing
License Lists

IMPORTANT. Read the following NXP ISELED® Software License Agreement (“Agreement”) completely By selecting the
“I Accept” button at the end of this page, or by downloading, installing, or using the Software, you indicate that you accept
the terms of the Agreement and you acknowledge that you have the authority, for yourself or on behalf of your company, to

Offline Activation

FAQ bind your company to these terms. You may then download or install the file(s). In the event of a conflict between the terms
Download Help of this Agreement and any license terms and conditions for NXP’s proprietary software embedded anywhere in the
Table of Contents Software file(s), the terms of this Agreement shall control. If a separate license agreement for the Software has been
FAQS signed by you or your company and NXP, then that agreement shall govern your use of the Software and shall supersede

this Agreement.

This is a legal agreement between your employer, of which you are an authorized representative, or, if you have no

employer, you as an individual (“you” or “Licensee”), and NXP Semiconductors Netherlands B V. on behalf of its affiliates
(“NXP"). It concerns your rights to use the NXP ISELED® software provided to you in binary or source code form and any
accompanying written materials (the “Software”) The Software may include any updates or error corrections or

documentation relating to the Software provided to you by NXP under this Agreement. In consideration for NXP allowing

you to access the Software, you are agreeing to be bound by the terms of this Agreement. If you do not agree to all of the =

Cancel

3.9 Download the SCR, Release notes and installation
package by selecting the packages

m Products  Applications  Support  About

NXP  Software & Support » Automotive SW - ISELED Software » SW32K1-ISELED-RTM-3.0.0 : Files

Software & Support
o Product Download
Product List
Product Search SW32K1-ISELED-RTM-3.0.0
Order History
Recent Product Releases Files License Keys Notes @ Download Help
Recent Updates
Show All Files &3 3 Files
Licensing
License Lists [J + File Description + FileSize ¥ File Name =
Offiine Activation @ T SO2KIISELED_RIM_500exe T5MB & S32K1 ISELED RTM. 3.0.0 6xe
@ -+ S32K1_ISELED_RTM_3.0.0_ReleaseNotes. pdf 602.6 KB & S32K1_ISELED_RTM_3.0.0_ReleaseNotes.pdf
FA(
Q @ -+ S32K1ISELED RTM_3.0.0_SCRxis 104 KB ¥ S32K1_ISELED_RTM_300_SCR xisx
Download Help
Table of Contents [ Download Selected Files l
FAQs
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3.10 Generate the license file for the S32K SDK ISELED driver by
selecting the License Keys tab.

m Products  Applications  Support  About

NXP  Software & Support » Automotive SW - ISELED Software » SW32K1-ISELED-RTM-3.0.0 : Files

Software & Support Product Download
Product List
Froduct Search SW32K1-ISELED-RTM-3.0.0
Order History

Recent Product Releases Files | License Keys | Notes © Download Help
Recent Updates
Show All Files 5 3 Files

Licensing
License Lists [+ File Description + Fllesize % File Name =
Offline Activation + S$32K1_ISELED_RTM_3.0.0.exe 1.5MB & S32K1_ISELED_RTM_3.0.0.exe
+ $32K1_ISELED_RTM_30.0_ReleaseNotes pdf 602 6 KB & S32K1_ISELED_RTM_3 0 0_ReleaseMNotes pdf
FA
Q + S32K1_ISELED_RTM_3.0.0_SCRxis 104 KB & S32K1_ISELED_RTM_30.0_SCR xlsx

Download Help

Table of Contents Download Selected Files

FAQs

L Account @ Enguish Can
S & AL~ a
PRODUCTS APPLICATIONS SUPPORT ABOUT

NXP - Softwars & Sugoon . License Information

Software & Support License Information

Product Lt

SW32K14SELED.RTM-300

Product Seasch

Order Hutory Generate

Rocont Procuct Relases

Recest Unmtes e Descripnion $I2K1x ISELED Controlier Middlewace (Binary) internal Evalustion License
Licensing Orbet Ny o ETRIOE B v el

License Lists Porase Osser Nunter

Olline Actveton Tkl Mo of Licanses 3
- -

Downioad kelp Apphcatio 1o Products )

Tatle of Conterts eooe  Qeacochen

FAOS "= S R e —

- -t ™ W

=0 RI>ee: _a_
= 0 BIee e
S~ -0 ECETT e
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3.11  Store the license file on your computer. Use this license file
during the installation of the NXP S32K ISELED Driver.
Important: the S32SDK_S32K1xx_RTM_4.0.0 installation
directory must be selected for the NXP S32K ISELED Driver
installation.

L Account @ English~ Cant
S & P a
PRODUCTS APPLICATIONS SUPPORT ABOUT

NP Sofwas & Support - View Licenses

Software 6 Scpport View Licenses
Product List
Poscs Satich Below are D ICNTAS YO SIS 10 view
e T T |
Recant Procuct Redtases
Racent Upcases License Applicable 10 Productis):
Yersion Descrintion
Licensang 300  SWIZKJSELEDRTMIO00
Liconse Lists » Dl ot B I ol
Ofine Actwaton :_ ridttonetd e
e 3308 TdTa
FAQ License Cumitty 1 Taocholin dad ~73
Downioad Help
Taie of Contarts Nﬂ_ﬂ:* D D— -,
FACS
#532K1x ISELED Controller Middieware (Simary) Internal Evalustion Licemse -
BSOS el . = wm & -—-
® License for ANY
S el . C — — S
- — — - -
o - - — s ™ e
- - -
omonni] Pmirans] S
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3.12 Run the ISELED Driver installer and click “Next”
e ISELED 4.8.0 for 532 SDK 4.0 Setup — *

Welcome to the ISELED 4.8.0 for
S32 SDK 4.0 Setup Wizard

This wizard will guide you through the installation of ISELED
4,8.0 for 532 5DK 4.0,

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue.

Next> | | Cancel
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3.13 Accept the terms of the License Agreement and continue
ISELED 4.8.0 for 532 SDK 4.0 Setup — it

License Agreement
Please review the license terms before installing ISELED 4.8.0 for 532 5DK 4.0,

Ca]

Press Page Down to see the rest of the agreement.

MXP ISELED®E SOFTWARE LICEMSE AGREEMENT v1.1 "

IMPORTAMT, Read the following MXP ISELED/® Software License Agreement
("Agreement”) completely. By selecting the “I Accept” button at the end of this page, or
by downloading, installing, or using the Software, you indicate that you accept the terms
of the Agreement and you acknowledge that you have the authority, for yourself or on
behalf of your company, to bind your company to these terms. You may then download
or install the file(s). In the event of a conflict between the terms of this Agreement and
Anv license terms and conditions for MXP's nronrietary software embedded anvwhere in

Please review the license agreement before installing ISELED 4.8.0 for 532 SDK 4.0, If you
accept all terms of the agreement, select the first option below. Click Mext to continue.

(®) I accept the terms of the License Agreement
()1 do not accept the terms of the License Agreement
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3.14 Select the license file that was saved previously

o |SELED 4.8.0 for 532 5DK 4.0 Setup — pod
License check
ISELED for 532 SDK license b

Please select a license fie.

| C:\DocumentsYicense. dat|

[P

3.15 If the license expires, please contact
gpis.software@nxp.com or your NXP sales representative
and ask for an Activation Code to register the software
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3.16 Select the components for the installation

# |SELED 4.8.0 for 532 5DK 4.0 Setup — 4
Choose Components
Choose which features of ISELED 4.8.0 for 532 SDK 4.0 you want to install. o

Chedk the components you want to install and unchedk the components you don't want to
install. Click Mext to continue,

Select the type of install AlPackages -
Or, select the optional - [#] Examples
mﬁﬁnmtﬁ 2t Drivers
' ' Documentation
Description
Space required: 23.2MB Position wour mouse over a component ko see ks
description,
MEP
<Back || Next> | | Cancel
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3.17 Select the installation path. Make sure that the installation
path is the same as the S32K SDK RTM 4.0.0 installation

folder
» ISELED 4.8.0 for 532 SDK 4.0 Setup — e

Choose Install Location
Choose the folder in which to install ISELED 4.8.0 for 532 50K 4.0, b

This Library needs to be installed on top of SDK release 4.0, Select 532K SDK install directory
to be used as a base for ISELED installation

532K SDE install directory.

|C:WKP\SSZDS.3.3\5321]5‘|5n1:|:ware‘|,5325DK_5321(1XK_F-'.TM_4.(| | Browse...

Space reguired: 23.2MB
Space available: 105.0GE

[P

< Back Mext = Cancel
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3.18 Finally click Install to start the setup
v ISELED 4.8.0 for 532 SDK 4.0 Setup - X

Ready to Install the Program
The wizard is ready to begin the installation. nMo

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

P

<Back | Instal | | cancel
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4. Troubleshooting

To verify the ISELED Driver installation please follow the next steps:

4.1  Start the S32 Design studio and select New S32DS Project
from Example in File menu.

e warkspaceS32DSARM - C/C++ - 532 Design Studio for ARM - [m] X

File Edit Source Refactor Mavigate Search Project Run Processor Expert Window Help

Open File...
(4 Open Projects from File System...

1 Processorbxpertpe [iseled_freemast..]
2 main.c [iseled_freemaster_s32k144/..]
3 main.c [test_project/src]

4 flesio_iseled_driver.h [Iseled_v1/...]

Exit

53205 Application Praject

AltsB, A

e STIOS Library Praject
~ Build/Debug

by
«
i
- Settings
@
&=
&

<

O items selected

[2] Problems %] Tasks 'EJ Console 32 [T Properties %y Debug [Gd Debugger Console

Clase Cul+W Makefile Project with Existing Cade
Clase All Crl +Shift + W C++ Project
Save Chilss CProject
SaveAs.. % Project...
Save All Ctrl+Shift+5 Canvert ta a C/C++ Project (Adds C/C++ Nature)
Revert 5 Source Folder
Move.. % Folder
4 Rename (o [€f SourceFile
&) Refresh f5 (W HeaderFile
&
Convert Line Defimiters To B Gftermitnipis
@ Class
Print... Crl+P
™ Bample..
Switch Workspace
e I Other.. Cul+hl
g Import..
g Export..
Properties Alt+Enter

FreeRTOS Task Aware Debugger Cansale

#-0- & - Qi S REDNIE - e

[k acces] | 5 |[EE] 4

= 8

BREUR #B-3-=0
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4.2  If the ISELED Driver example application does not appear
in the examples list, it means that the installation path for
the ISELED Driver did not match the S32K SDK RTM 4.0.0
installation folder. Please see step 3.16.

[E 53205 Project from Example.

Create 532DS Project from Example

Project name: | jse| ed_freemaster_s32k144

| Enter search text...

Examples:

» (= 532K116 SDK RTM v4.0.0 Example Projects
» (= 532K118 SDK RTM v4.0.0 Example Projects
» = 532K142 SDK RTM v4.0.0 Example Projects
» [ 532K142W SDK RTM v4.0.0 Example Projects
v (=5 532K144 SDK RTM v4.0.0 Example Projects
v [= demo_apps
(= adc_low_power_s32k144
= ammclib_s32k144
= csec_boot_protection_s32k144
= flexcan_encrypted_s32k144
= freemaster_s32k144
= freertos_s32k144
= hello_werld_s32k144
(= iseled_freemaster_s32k144
(= lin_master_s32k144
= lin_slave_s32k144
(= sest_s32k144
v = driver_sxamples
v (= analog

Description:

This is a simple application created to act as a template project for 532

Design Studio,

The example documentation can be found in the 532 SDK
documentation at Examples and Demos section,

(< 5DK_PATH= /doc/Start_Here html)

)

Cancel

e S
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|
2

4.3  Another way to verify the ISELED Driver installation is to
check if the ISELED libraries are present in the S32K SDK
installation folder

> ThisPC » 0SDisk (C:) » NXP » 532DS_ARM_v2012.R1 » 532D5 » 532 SDK_RTM_3.0.0 > platform » drivers » src » iseled » gecc

.

Mame Date medified Type Size
| | libiseled_532K11x.a 11/27/2018 5:48 PM A File 42 KB
| | libiseled_532K14x.a 11/27/2018 5:48 PM A File 42 KB

5. Starting from S32K SDK ISELED example application

The S32K SDK ISELED driver is provided with the example application.
The example application uses FreeMASTER SW component from NXP,
used for data visualization and operation of project flow. In case the
FreeMASTER SW component is not installed on your computer, please
visit the

www.nxp.com/freemaster website to download the installation
package of the FreeMASTER component.

For a detailed description of the ISELED Driver example application,
please refer to the ISELED_UserGuide document that can be found in
the installation path under the “doc” folder.

To start the user application based on this example, please follow these
instructions:
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5.1  Start the $32 Design studio and select New S32DS Project
from Example in File menu.

= workspaceSI2DSARM - C/Cav+ - 532 Design Studio for ARM - o x
Fila Edit Source Refactor Mavigate Search Project Run  Processor Expert Window Help
Open File... S cioDs b Projact J B
[ Open Projects from File System...
=g
Close ol Makefile Project with Ex
Clase Al Ctil+Shift+W Cos Project
Save Ctiles Eleg=s
_—— Project...
Save Al Ctrl+Shift+ Canvert ta a C/C ++ Praject (Adds C/C++ Nature)
Revert Source Folder
Mave... Folder
[ Rename. o Source File
&) Refresh - Header File
Convert Line Delimiters To > (e T
Class
£ print. Ctrl+p
EBample...
Switch Workspace >
— Other... Ctrleh
e Impott..
By Export.
Properties Alt+Enter
1 Processorbxpertpe [iseled freemast..]
2main.c [iseled_fresmaster_s32Kk144/..)
Imain.c [test_project/src]
4 flesia_iseled_driverh [Iseled_v1/..]
Bit
= STIOS [hiary Project
~ Build/Debug [2] Problems ] Tasks 'E) Console 52 [I] Properties %5 Debug [} Debugger Console BB #BE--= 0O
§ FreeRTOS Task Aware Debugger Console
~
k<
~ Settings
g
v
<« 511 >
Oitems selected H
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5.2 Select the iseled_freemaster_s32k144 example application
from the S32K144 examples list.

B8 s32D5 Project from Example. ] *®

Create $32DS Project from Example

Project name: | jseled freemaster_s32k144

Enter search text...

Examples: Description:
» = 532K116 SDK RTM v4.0.0 Example Projects A This is a simple application created to act as a template project for 532
5 (= 532K118 SDK RTM v4.0.0 Example Projects Design Studic. . .
5 = 532K142 SDK RTM v4.0.0 Example Projects The example_ documentation can be found in the 532 SDK
) documentation at Examples and Demos section.
» = 532K142W 5DK RTM w4.0.0 Example Projects (<SDK_PATH> /doc/Start Here.hitml)

v (= 532K144 SDK RTM v4.0.0 Example Projects
v = demo_apps
= adc_low_power_s32k144
= ammclib_s32k144
= csec_boot_protection_s32k144
= flexcan_encrypted_s32k144
(= freemaster_s32k144
= freertos_s32k144
[ hello_werld_s32k144
[ iseled_freemaster_s32k144
(=5 lin_master_s32k144
= lin_slave_s32k144
L= sest_s32k144
v [ driver_examples

v (= analog o
~ . .

@ Finish | Cancel
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5.3  Build the project by selecting the build command from
the menu bar and selecting the Debug_FLASH option.

W workspace53205.3.3_Examples - C/C++ - 532 Design Studie for 532 Platform
File Edit Seource Refactor MNavigate Search Project CenfigTools Run Window Help

Brlb|®-R-RICF F IV NS B-E@-B-F-C-i-0-%-id PR

Ry Projct Explorer 52 |IIDSSUGLASHIN |

v [0 iseled_freemaster s32k144: Debug_FLASH
> ﬁ'} Binaries
> @] Includes
> [ Project_Settings
> 2 SDK
5 [ board
>
>
>

= src

(7= Debug_FLASH

(2; Debug_Configurations
> [E doc
> [E Doxygen

Ef a.cproject

Ef description.txt

ﬁ Iseled_Driver.pmp
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5.4

Choose the debugging option by selecting Run menu

and Debug Configuration item. Here you can select the
Debug interface option.

H workspace$32D5.3.3_Examples - C/C+ + - 532 Design Studio for 532 Platform

File

i

>
>

Edit Source Refactor MNavigate Search Project ConfigTools Run Window Help
HE 2-S-BIOFFIC ISR Fn CobFl |8 - R [E
&, Debug F11
roject Explorer
[ Project Explorer 53 A5 =0
i »
v [ iseled_freemaster_s32k144: Debug_FLASH Ry
ﬁh Binaries Run As *
hill Includes un Configurations...
Includ Run Config
2 Project_Settings
ebug Histol >
& SDPJ( 9 Debug History
2 board Debug As >
2 src Debug Configurations...
= Debug_FLASH
{4 Debug_Configurations Toggle Breakpoint Ctrl+5hift+B
@ doc Toggle Line Breakpoint
(#% Doxygen Toggle Method Ereakpoint
g‘ a.cproject Toggle Watchpoint
B description bt
I l=ced_Drverprap & Skip All Breakpoints Ctrl+Alt+B
B Remaove All Breakpoints
Breakpoint Types >
q External Tools >

w Debug Cenfigurations

Create, and run confi ti

x| B>~

type filter text
[£] C/C++ Application
[E] C/C++ Remote Application
£ Eclipse Application
[£] GDE Hardware Debugging

~ e GDE PEMicro Interface Debugging
E iseled_freemaster_s32k144_debug_flash_pemicro
~ [t GDB SEGGER J-Link Debugging
iseled_freemaster_s32k144_debug_flash_jlink

B g
B Launch Group for 532 Debugger
= 532 Debugger
= 532 Debugger Flash Programmer
= VLAB Simulater Debugging

Filter matched 13 of 22 items

Configure launch settings from this dialog:

- Press the ‘Mew' button to crea..figuration of the selected type.

- Press the 'Duplicate’ button ...opy the selected configuration.

- Press the 'Delete’ butten to remove the selected configuration.

:",=‘-:> - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the 'Perspectives’
preference page.

@

Debug Close
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For more details about the S32K SDK ISELED driver, please open the
driver documentation, stored in the installation folder.

For a detailed description of the ISELED Driver example application
please read the ISELED_UserGuide document that can be found in the
installation path under the “doc” folder.

Note: The S32K SDK ISELED example project is using
FreeMASTER SW component from NXP, used for data
visualization and operation of project flow. In case the
FreeMASTER SW component is not installed on user computer,
please visit the
www.nxp.com/freemaster
to download the installation of the FreeMASTER component.
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